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Our mission is to offer innovative technology solutions and exceptional service. 
 

All BRG Time Zone Displays are Made in the USA. 
  



 

Multimedia Time Zone Clock 

 

The BRG Multimedia Time Zone Clock displays world times, world maps, news and other information and 
plays video files. 

The system is comprised of four main components.  These are the Moving World Map, Media  Player, 
Message Ticker and Media Scheduler. 

Moving World Map - This is the main moving world map program.  It includes many configurable 
features, include zoom and pan, selectable maps, and selectable overlays. 

Media Player - This program plays the selected or schedule video files.  The files can reside in internal 
memory or on a USB drive plugged into the side of the clock.  Various sample Earth and Space vides files 
are available in the folder C:\videos.  Videos are played full screen by default; however, they may also be 
played in one of six small windows on top of the world map.  The videos may be played full screen or as 
smaller inset videos in one of six locations on the screen. 

Message Ticker - The message ticker is capable of retrieving and display information from public News 
and Information feeds, or display a text file located on the Media Player or on a network drive.   News 
feeds are typically a web site the supports the RSS feed format.  All you need to do is point the message 
ticker to one or more of these web sites.  The height of the message ticker is configurable. 

Media Scheduler - This program controls various aspects of the system, including scheduled video file 
play.  When a video is scheduled to play, the message ticker is disabled before playing the video.  Once the 
video is completed playing, the message ticker is restored. 

Remote Access 

The display many be accessed and controlled remotely.  This useful for technical support and for operating 
remotely.  First, reduce the world map size by entering CTL-L on the keyboard.  Next, click on the Remote 
Access icon on the Windows desktop.  Run the program when prompted.  A user ID and password will be 
displayed.  On the remote computer, go to the web site dwservice.net and enter the user ID and password to 
access media display. 

Radios or No Radios. 

The Multimedia Display is available without Wi-Fi and Bluetooth radios for use in secure locations.   If the 
model has Wi-Fi, then a wireless keyboard with touchpad will be included.  If the model does not have 
radios, then a USB keyboard with touchpad will be included.  Plug this keyboard into the USB jack on the 
side of the display.  

  



 

Moving World Map Operating Instructions 

Special Map Commands 

1. CTL-L – Toggles between Full Screen and Window Modes 
2. CTL-T – Save a Screenshot 
3. (+) - Zoom In 
4. (-) – Zoom Out  
5. After zooming in, hold down the left mouse button to pan the map 
6. Mouse Thumbwheel – Zoom IN and Out 
7. Moving mouse cursor to the top of the screen while in full screen mode will display the configuration bar. 
8. Moving the mouse cursor while in full screen mode will display an “X” at the top of the screen.  Clicking on 

this indicator will change from Full Screen to Window Mode. 
9. When using the mouse wheel to zoom, press and hold the Shift key cause a faster zoom change.  

 

Hovering the mouse cursor over a button will popup help text 

 

 

How to … 
Connect the Media Player Time Zone Display to a Computer Network – If the bottom message ticker 
is displayed then, using a keyboard with touchpad, close down or minimize the message ticker.  Left click 
on the down arrow or “X” close buttons located at the right end of the ticker.  Next, left click anywhere on 
the world map, then press CTL-L to reduce the map size.  Move the mouse arrow to the bottom of the 
screen to popup the Windows task bar.  At this point, use normal Windows tasks to configure The Wi-Fi or 
hardware network connections.  You can enter “Network Connections” in the search box to locate the 
network configuration screen.  

Zoom and Pan to Areas of Interest on the Map – If the wireless keyboard is available, first turn on the 
power switch on the side of the keyboard.  Then press and hold the button that represents the left button on 
a mouse.  Next slide a finger over the slider located on the touchpad.  Alternatively, use the plus (+) and 
minus (-) keys to zoom in and out.   

Once zoomed into an area press and hold the left button again.  Next, use another finger on the open area of 
the touchpad to reposition the map to the desired location.  When through using the wireless mini-
keyboard, turn it off using the switch on the side of the keyboard. 



 

The map will remain at the selected zoom and pan location through power cycles. 

Turn Nighttime Shading On and Off – There may be times when it’s advantageous to disable the 
nighttime shading feature, such as when zooming in and panning to other areas of the globe.  Move the 
mouse cursor to the top of the screen until the configuration bar displays.  Click the “Greyline” tab.  Click 
on the “Show” button to toggle shading on and off. 

Display a Digital Clock on the Map – Move the mouse cursor to the top of the screen until the 
configuration bar displays. Click on the Clock tab to make changes to the clock display.  Changes include 
type font and style, size, screen location, local or UTC time, offset from UTC time, date, displays seconds 
or not, and more.  Click the Show button to display or remove the clock(s). 

Display Sunrise and Sunset Times for the Home location - Move the mouse cursor to the top of the 
screen until the configuration bar displays. Click on the Sunrise tab.   Click the Show button to display or 
remove the Sunrise/Sunset times. 

Define Home Location - Move the mouse cursor to the top of the screen until the configuration bar 
displays.  Click on the Stations tab.  The home location is used to center the map.  In the Home section, 
click on Configure, then click on Configure. Click on Lat/Long.  Enter the Lat/Long values for your home 
location.  There is a link next to these value fields that will take you to Google Maps.  Once there, move to 
your home location on the map and click on it.  Google Maps will display the Lat/Long values for this 
location.  Enter the proper directions and values.  Don’t use negative values.  Don’t change the Locator 
value.  Enter the home location name and set the desired time zone for his location.  Click the OK button. 

Display Custom Points of Interest Labels - Move the mouse cursor to the top of the screen until the 
configuration bar displays.  Click on the Stations tab. In the Manage section, click on Definitions.  The 
table is already configured with points of interest examples. To delete and existing point of interest from 
the table, first click on the desired item, then click on the delete button.  To add a point of interest label, 
click on the Add button.  Enter the Lat/Long values for point of interest location.  There is a link next to 
these value fields that will take you to Google Maps.  Once there, move to the point of interest location on 
the map and click on it.  Google Maps will display the Lat/Long values for this location.  Enter the proper 
directions and values.  Don’t use negative values and don’t change the Locator value.  Enter the point of 
interest name location name and set the desired time zone for his location.  Click the OK button.  In the 
Show section of the configuration bar, click on the Stations button to toggle the display of the points of 
interest.  In the Show section, you can also configure various details to be included with the points of 
interest labels.  The size of the labels is controlled by the font size in the Manage section.  Clicking the 
green pin heads on the configuration bar centers the map on the selected point of interest. 

Display Google Earth – A wired or wireless network connection is required to use this feature.  Google 
Earth may be displayed in several ways.  It can be displayed directly by pressing CTL-L to minimize the 
World Map.  Then double click on the Google Earth icon to start the program.  Google Earth will start up 
in the last saved zoom and pan location.  There are various ways to control and configure Google Earth.  
For more help, go to the tool bar at the top of the screen and click on the Help > Help Resources.  To save 
the current Pan and Zoom location, click on View > Make this my start location.  To end the Google Earth 
session and return to the World Map, close Google Earth.  Next, click on the World Map program and enter 
CTL-L to maximize the map.    



 

Another way to start Google Earth is to use the Media Scheduler.  First press CTL-L to minimize the 
World Map.  Drag the map program over if it’s covering the Media Schedule program.  Entries may be 
added to the run schedule to start and stop Google Earth.  For example to start Google Earth at a specified 
time, click on the “Create New Alarm Record”  button.  In the alarm name field, enter “RunGoogleEarth” 
or “Run Google Earth”, without quotes.  Then press the Enter key.  Next, select the desired Play Function.  
The program may be started at a specified time, or started periodically, such as once per hour.  It can also 
be configured for manual start only.  To stop Google Earth and start the World Map,  click on the “Create 
New Alarm Record”  button.  In the alarm name field, enter “RunWorldMap” or “Run World Map”, 
without quotes.  Then press the Enter key.  It can be scheduled to start some time following the start of 
Google Earth. 

Display a LOGO or other image on the screen. – There are at least two ways to display a logo on the 
map.  First, the World Map logo feature may be used by going to View > Logo.  Select a file and display it 
in various sizes and locations on the screen.  Another way to display a logo or other image is to use the 
Media Scheduler.  Most popular image formats are supported.  Press CTL-L to minimize the map and 
access the media scheduler.  Then create a new schedule entry by clicking on “Create New Alarm Record”.  
If the image file name is “201 NASA Logo.JPG” (must begin with three numbers) then enter 201, followed 
by the screen location identifier such as UL for upper left.  Next enter the image designator JPG followed 
by a three digit play time in sections.   The complete entry would be “201UL JPG900”, where the 900 
indicates the logo will display for 900 seconds, or fifteen minutes.  If you want the logo to display 
continuously, then make for schedule entries to play the logo every fifteen minutes.  To increase the logo 
size, a single multiplier digit may be included after the screen location identifier.  For example, an entry of 
“201UL5 JPG900” (note the “5” after the “UL”) will enlarge the image.  The “Insert Video Size 
Multiplier” at the bottom of the scheduler screen can also be used to adjust the image size.   This value is 
multiplied times the single digit value to obtain the total image size.  

Change the message ticker default content – Change the message ticker – by default, the message ticker 
displays the contents of a text file.  To change the message, left click on the ticker message.  Notepad will 
popup displaying the contents of the current message file.  Change as needed and save the file by typing 
CTL-S.  Close the text editor by left clicking on the “X” in the upper right corner.  Refresh the message 
ticker by hovering the mouse pointer over the message ticker, then press function key F5 

Display News or other information on the message ticker – The message ticker is capable of retrieving 
and display information from public News and Information feeds.   These feeds are typically a web site the 
supports the RSS feed format.  All you need to do is point the message ticker to one or more of these web 
sites.  Feed san be found by searching the web for categories of feeds such as “news RSS feeds” or 
“weather RSS feeds” or “science RSS feeds”  Once an RSS feed is selected, copy the URL from the 
browser and enter it into the message ticker by left clicking on the three lines at the left end of the message 
ticker.  Next, click on File, then Manage Feeds.  Paste the URL copied to the URL line in the Desktop 
Ticker configuration screen.  Click the “Add” button.  The URL will be added to the list.  Click on one or 
more check boxes next to the URL’s for the feed you want to display.  Click the OK button to save and exit 
the configuration window. 

Remove the message ticker – First left mouse click on the “x” on the right end of the ticker. Then left 
click on the map.  Next, type CTL-L to reduce the map window size of the map .  Find the Media Play 



 

Schedule Editor.  On the bottom of the window, change the Number of Tickers to 0 and press enter.  Left 
click on the map window, then press CTL-L to change the map to full screen. 

Stop Scheduled Video Play and return to the World Map –  Type CTL-L to reduce the map window 
size of the map.  Find the Media Play Schedule Editor.  You may need to move the map to the side of the 
screen to find the Media Play Schedule Editor.  To stop schedule video play, uncheck the “Enable 
Scheduler” check box.  Leave the schedule window open as this program is also used to synchronized time 
between the LED time zone clock and the Media Player.  Click on the map and type CTL-L to return to full 
screen mode.  

Naming Videos – The file name structure for video files is NNN.HHMMSSDDD…DDD.MP4 where 
NNN is the fixed length file number from 001 to 999, a period (.) separates the file number and the play 
length, HHMMSS is the optional video play length in hours, minutes and seconds, DDD…DDD is the 
optional variable length description. MP4 is the video type.  Various other video types are acceptable.  The 
minimum required file length is NNN.MP4 where NNN is the file number.   

Play videos located on a USB drive plugged into the jack on the side of the clock – When a USB drive 
is plugged into the side of the clock, it will normally be assigned to drive D.  The path will need to be 
changed in the Media Play Schedule Editor.  Reduce the map size by typing CTL-L and locating the Media 
Play Schedule Editor.  Change the video file path on the lower left area of the editor screen.  

To play a video either at a scheduled item or immediately, it must first me entered into the schedule. Click 
on the “Create New Alarm Record” button.  Then enter the three digit file number (001-999) into file name 
area at the center of the screen, the press Enter.  At this point, you can play the video immediately by 
clicking on the “Play Selected Item” button.  Pressing “q” while the video is playing will stop video play 
and return to the schedule screen. 

There are a few ways the video can be scheduled to play.  To play at a specific time, select “Play once at 
the scheduled time” from the Play Function drop down list.  Then enter a time to play.  The video will play 
every day at the specified time, unless some days are omitted using the day selection buttons and check 
boxes.  To play the same video multiple times, simply add more play schedules with different play times. 

If you have 10 videos you want play at one specified time, you can name them as a sequence of file number 
such as 050 to 059.  In the file name area of the schedule entry, use 050TO059 for the file name, then press 
Enter. Text after the eight digit file number range is ignored.  When it’s time to play, the videos will play 
one at a time, in sequence.  When the sequence concludes it will start over with the sequence. 

There are also periodic play functions that will play videos throughout the day without the need to enter a 
play time.  Using the functions with one or more schedule entries allows periodic play every 5, 10, 15 20, 
30 or 60 minutes.  Combine this with the play range feature to have a different file play each time a video 
plays. 

By default, videos play full screen.  However if a two digit screen location identifier is included after the 
schedule file number, then the video will be placed on top of the world map in a small window at the 
location specified by the two digit identifier.  Valid play window locations are Upper Left (UL), Upper 
Center (UC), Upper Right (UR), Lower Left (LL), Lower Center (LC) and Lower Right (LR). 



 

Enable/Disable Scheduled Media Player Power Down – To extend the life of the Media Player display, 
the Media Player is configured to power off Monday through Friday at 10:00 pm and 6:00 pm on 
weekends.  It will power on every day at 6:00 am.    To edit the power down times or days, access the 
Media Play Schedule Editor.  Reduce the map size by typing CTL-L and locate the Media Play Schedule 
Editor.  Search the schedule list for “POWEROFF” or “POWERDOWN”.  By default, there is one entry 
for week days and one for weekends.  You can edit the power down times or days.  To stop the power 
down and display the map continuously, delete the “POWEROFF” schedule entries.  The power on time is 
controlled by a setting in the system bios which is set to 6:00 am by default.  This can be changed by 
editing the appropriate entry in the system bios.  To return to normal operation, click on the map and press 
CTL-L. 

Change time synchronization from the clock’s oven controlled oscillator (OCXO) to network time 
protocol (NTP) -  By default, the time zone clock OCXO maintains time for the entire display.  However, 
the display can be reconfigured to use network time (NTP).  In the time zone clock, set mode 32-12=0.  In 
the media scheduler program, uncheck “Set Media Player Time from Clock”, and check “Send UTC Time 
to Clock Once a Minute” 

Access and Control the Display from a Remote Computer -  The display may be remotely accessed and 
controlled for technical support purposes for simply controlling the display remotely.  To enable remote 
access, first left click on the map, then press CTL-L to reduce the map size. Double click the Remote 
Access icon on the desktop.  This program will produce a user ID and password.  On the remote PC, sing a 
browser, go to the web site dwservice.net .  Enter the user ID and password provided.  The media play 
screen will then display on the remote computer. 

Display Video in a Small Screen on top of the World Map – the media player supports picture-in-picture 
mode.  Videos may be scheduled to play on a small screen in up to six different locations on the screen, 
Upper Left (UL), Upper Center (UC), Upper Right (UR), Lower Left (LL), Lower Center (LC) and Lower 
Right (LR).  By default, videos play full screen.  However if a two digit screen location identifier is 
included after the schedule file number, then the video will be placed on top of the world map in a small 
window at the location specified by the two digit identifier.  For example, a schedule file name entry of 
035LL will place video 35 on top of the world map in a small window in the lower left area of the screen.  
A schedule file name of 011to200UC will play one file from a sequence of file names 11 through 200 at the 
specified time and placed on top of the word map in a small window located at the top center of the screen.  
When the scheduled play time is activated, a different video will play from the specified sequence. 

The two digit screen location designator may optionally be followed by a single digit magnification 
designator 0 through 9.  For each step of magnification the widow size will be increases 100 pixels, with 0 
being no magnification and 9 being 900 pixels magnification.  Example, a schedule entry of 011to100LL5 
will cycle through a range of videos, playing one video per schedule instance, with file names 11 to 100.  
The video will display in the lower left (LL) corner of the screen, and will be 500 pixels large that the 
default video size,  

If a full screen video and a windowed video are scheduled to play at the same time, the windowed video 
will be placed on top of the full screen video (picture-in-picture). 



 

Add New Videos - New videos may be added using the USB port located on the left side of the display.  
First, plug the USB drive containing the video(s).  Minimize the world map by pressing CTL-L to access 
Windows functions and features.  Pressing CTL-L again restores the map to full screen.  The videos may 
be played directly from the USB drive by changing the file path on the Media Play Schedule Editor screen.  
Or, the videos may be copied to the display from the USB drive to C:\videos.  Before copying the videos to 
the display, then must be named starting with 201 and above so as not to conflict with already installed 
videos.  The file name must begin with three numbers, optionally followed by any text to further identify 
the video.  Existing videos on the display may be deleted to make room for more videos.  In this case, the 
file number may be reused. Once the videos are copied to the display the USB drive may be removed. 

Configure the IR Remote Control – The clock’s IR remote control can be configure to perform special 
functions affecting the media player.  Setting Mode 37-2=4 allows the remote’s Timer Control button to 
toggle power on a Samsung brand TV/Monitor.  Setting Mode 37-2=5 allows the Timer Control button to 
restart the media player.     



 

Media Play Scheduler 

 

This program should always be running. 

1. Schedule files can be saved and reopened. 
2. Current file name loaded 
3. Play schedule entries and power down commands 
4. Create a new schedule record 
5. File number or range of numbers (001TO999) 
6. Remove the current schedule record 
7. Day(s) of the week to play 
8. Time of day to play 
9. Play functions 
10. Folder where video files are located.  Change this path to D:\videos if a USB drive is used. 
11. Play the selected file immediately 
12. Time Data Serial com port 
13. Check when sending time from the time zone clock to the media display 
14. Check when sending UTC time to the media display 
15. Check when sending local time to the media display (default) 



 

16. Check when sending UTC time from the media display to the time zone clock 
17. Enter the number of message tickers that will be used.  Enter 0 if no tickers will be used. 
18. Enable the video paly scheduler by checking the box.  Uncheck to disable the scheduler 
19. If the height of the message tickers are changed from the default, then the inset video vertical position may 

need to be adjusted. 
20. Inset Lower Video Vertical Position 
21. Inset Video Width – The height is automatically adjusted when this value is changed 
22. Use IR to control power to TV/Monitors.  No applicable when Video Monitors with TV function are used. 
23. TV power control serial port  
24. Remove message tickers as needed while displaying  videos 
25. Adjust screen width (factory preset) 
26. Adjust screen height (factory preset) 
27. Inset Video Size Multiplier – this is used with the video size digit in the video file name 
28. Schedule Program version number 
29. Save and Restore all map configuration parameters 

 

 



 



 



 

 

 

 

  



 

 



 

 



 

 



 



 

 

 



 

 

 

 

 

 

 

 

 

 

 



 

 Media Player 
 

Video file names use the following format: 

 

NNN.HHMMSSDDD…DDDD.MP4 

Where: 

NNN = file number 001 to 999 

HH = play length hours 

MM = play length minutes 

SS = play length seconds 

DDD = Description 

MP4 = video file type 

 

While videos are playing, pressing the right arrow key will step forward in the video.  Multiple press can 
be used to end the video. 

  



 

Warranty Agreement 

BRG Precision Products One Year Warranty 
 

1. Term of Coverage 
Coverage will be for 1 year. Claims must be made during the Warranty Period. This Agreement is not renewable. 
The warranty becomes null and void if complete payment is not made within the terms specified under Terms of 
Payment.  
 
2. Warranty 
BRG Precision Products, Inc. warrants the Product against defects in workmanship and materials during the 
Coverage Period. 
 
3. Coverage 
BRG Precision Products, Inc. will, at its option, repair or replace the defective Product free of charge, provided that 
you notify BRG Precision Products, Inc. of the Product defect within the Coverage Period, and provided that BRG 
Precision Products, Inc. through inspection establishes the existence of such a defect and that it is covered by this 
Agreement. BRG Precision Products, Inc. will, at its option, use new and/or reconditioned parts in performing 
warranty repair and building replacement products. BRG Precision Products, Inc. reserves the right to use parts or 
products of original or improved design in the repair or replacement. If BRG Precision Products, Inc. repairs or 
replaces a Product, the warranty continues for the remaining portion of the Coverage Period without extension. All 
replaced Products and all parts removed from repaired Products become the property of BRG Precision Products, 
Inc. BRG Precision Products, Inc. covers both parts and labor necessary to repair the Product, and return shipment 
to the Customer via a BRG Precision Products, Inc.-selected non-expedited surface freight within the contiguous 
United States and Canada. Alaska and Hawaii return shipments to the Customer are via non-expedited air freight. 
 
4. What Is Not Covered 
This Agreement does not cover costs related to the removal, installation, or field troubleshooting of the Product 
under the terms of the Agreement if, and not limited to: 
a) the Product has been misused, neglected, improperly installed, physically damaged or altered, either internally 
or externally, or damaged from improper use or use in an unsuitable environment; 
b) the Product has been subjected to fire, splashed water (unless specifically ordered to be water resistant), 
submersion into any liquid, generalized corrosion, biological infestations, or high input voltage including lighting 
strikes and generators operating outside the limits of their Product specifications; 
c) repairs have been done to it other than by BRG Precision Products, Inc. or its authorized service centers, or as 
assigned by BRG Precision Products; 
d) the Product is used as a component part of a Product expressly warranted by another manufacturer; 
e) the Product's original identification (trade-mark, serial number) markings have been defaced, altered, or 
removed; 
f) the Product is located outside of the United States and Canada; 
g) the customer has misrepresented the Product information provided to BRG Precision Products, Inc. in order to 
receive coverage under the terms of this Agreement. This Agreement does not warrant uninterrupted or error-free 
operation of the Product; 



 

h) Product malfunction or damage resulting from electromagnetic or solar radiation; 
i) Shipping charges to the factory more than 30 days after first receiving the product; 
j) Undesirable operation resulting from changes to public law after the product was purchased, such as changing 
the dates for daylight saving time. 
k) Normal wear and tear relating to the non-operating functions of the equipment such as discoloration from direct 
sunlight, heat, etc. 

5. Disclaimer and Limitation of Liability 
TO THE EXTENT PERMITTED BY APPLICABLE LAW, OTHER THAN THE EXPRESS WARRANTY SET FORTH IN THIS 
AGREEMENT, BRG PRECISION PRODUCTS, INC. MAKES NO ADDITIONAL WARRANTIES, EXPRESS OR IMPLIED, AND 
DISCLAIMS ALL IMPLIED WARRANTIES, WHETHER IN FACT OR BY OPERATION OF LAW, STATUTORY OR OTHERWISE, 
INCLUDING WARRANTIES OR CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. ANY 
WARRANTIES THAT MAY NOT BE DISCLAIMED UNDER APPLICABLE LAW ARE LIMITED IN DURATION TO THE 
WARRANTY PERIOD. NO WARRANTIES, EXPRESS OR IMPLIED, WILL APPLY AFTER THIS PERIOD. IN NO EVENT WILL 
BRG PRECISION PRODUCTS, INC. BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, LOSSES, COSTS OR EXPENSES HOWEVER ARISING WHETHER IN CONTRACT OR TORT INCLUDING 
WITHOUT RESTRICTION ANY ECONOMIC LOSSES OF ANY KIND, ANY LOSS OR DAMAGE TO PROPERTY, ANY 
PERSONAL INJURY, ANY DAMAGE OR INJURY ARISING FROM OR AS A RESULT OF MISUSE OR ABUSE, OR THE 
INCORRECT INSTALLATION, INTEGRATION OR OPERATION OF THE PRODUCT. SOME STATES DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU. BRG Precision Products, Inc. neither assumes nor authorizes any other person to assume for it any 
other liability in connection with the repair or replacement of the Product. 
 
6. Claim Limits 
Claims are limited to repair or replacement, or if in BRG Precision Products, Inc.'s discretion that is not possible to 
reimbursement up to the purchase price paid for the Product. In no event will BRG Precision Products, Inc.'s liability 
under this Agreement exceed the purchase price paid for the Product. 
 
7. Cancellation 
You may cancel this Agreement by providing to BRG Precision Products, Inc. written notice of your wish to cancel. 

8. Insurance 
This Agreement is not a contract of insurance. 

9. Amendment and Waiver 
No amendment, supplement, consent or waiver, express or implied, to or of any provision of this Agreement will be 
effective unless in writing signed by the parties hereto and then only in the specific instance and for the specific 
purpose given. 
 
10. Assignment 
The Customer may assign or transfer this Agreement provided BRG Precision Products, Inc. is advised by the 
Customer in writing of such assignment and the new system owner's information. 
 
11. Governing Law 
This Agreement will be governed by and interpreted exclusively in accordance with the laws of the State of Kansas, 
without reference to provisions concerning conflicts of laws. The provisions of the United Nations Convention on 



 

Contracts for the Sale of Goods are hereby excluded. 
 
12. Arbitration 
Any controversy or claim arising out of or relating to this Agreement, or the breach of it, shall be settled by 
arbitration in accordance with the relevant rules of the American Arbitration Association, and judgment on the 
award rendered by the arbitrator may be entered in any court having jurisdiction thereof. The place of arbitration 
shall be Wichita, Kansas, United States of America. There shall be one arbitrator. 
 
13. Severability 
If any provision of this Agreement is found by any court or arbitrator to be invalid, illegal or unenforceable, the 
validity, legality and enforceability of the remaining provisions will not be affected thereby. 
 
14. Entire Agreement 
This Agreement constitutes the entire contract between the parties concerning the subject matter of this 
Agreement and supersedes all marketing brochures and other expectations, understandings, communications, 
representations and agreements, whether verbal or written, between the parties. THIS AGREEMENT GIVES YOU 
SPECIFIC LEGAL RIGHTS AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. 

Once a return authorization number is obtained, ship the products to: 

BRG Precision Products 
Attn: RA# xxxxxxx (where xxxxxxx is the authorization number provided) 
600 N. River 
Derby, KS 67037 
 

Optional Extended Warranty: 

A two-year extended warranty is available.  The extended warranty must me purchased before the end of the 
standard warranty.  The two-year extended warranty costs 20% of the product purchase price. 

Optional Advanced Replacement Service (“Hot Swap”): 

For critical applications, BRG Precision Products recommends purchasing a complete backup product.  If a backup 
product is too expensive or the application is only semi-critical, BRG Precision Products recommends the optional  

Replacement Service ("Hot Swap") 

This service allows the customer to receive a replacement product right away to replace a defective product that is  

covered under warranty. BRG Precision Products will pay for ground shipping to send the replacement product.  
The customer is responsible for expedited shipping charges over the cost of ground shipping. The customer is 
responsible for shipping charges to return the defective product.  The Replacement Service is only available for 
shipments to the U.S. and Canada. 

When the customer receives the replacement product, the defective product must be returned to the factory 
within 30 days.  The invoice for the replacement product will then be voided; otherwise, the full invoice amount for 
the replacement product is due.   This service is only available in conjunction with warranty repairs. 

 This replacement service may be purchased for 10% of the products purchase price at the time of the initial 
purchase. The replacement service may also be purchased after the initial product purchase and before the 



 

standard warranty expires for 15% of the product purchase price. The term of this service ends when the warranty 
expires.  This service may be repurchased for 10% of the product purchase price when a two-year extended 
warranty is purchased.   The product replacement service is only available on selected models. 

30 Day Return Policy: 

No returns will be accepted without prior written authorization of BRG.  Incorrect merchandise received will 
receive prompt re-shipment of correct items.  Incorrect merchandise, other than custom items, may be returned, 
shipped prepaid, and will be exchanged on an equivalent basis.  

Merchandise, other than custom items, that cannot be used may be returned at a 25% restocking charge if items 
are shipped prepaid in the original boxes.  Carrier is responsible for parts damaged in shipment. The customer 
should have driver sign for damaged carton on delivery receipt and make a claim with the freight company. Please 
insist that the carrier's representative conduct an inspection, and retain all packing materials for the inspector.  
Please report promptly for immediate follow-up on short shipments.  No action arising from any sale by BRG may 
be brought by a customer more than one year after the date of shipment.  

Terms of Payment: 

New accounts require prepayment. International orders require prepayment by Telegraphic Transfer (bank wire). 
For established customers, payment is due in full within 30 days from invoice date. Other payment methods include 
Visa, Mastercard, American Express, Discover, Novus (Domestic Only).  Add 4% for ground shipping in the U.S. and 
Canada.  Domestic shipping is prepaid for U.S. Government orders.  Other shipping methods are available. All past 
due accounts will be subject to a finance charge of 1.5% per month. BRG may cancel or delay future deliveries if 
customer fails to make prompt payment or if customer's financial condition warrant such action in BRG's opinion. 
BRG is not responsible for delays. The customer will be contacted and given the choice of receiving a partial 
shipment or waiting for the full shipment.  The firmware license may be suspended, limiting functionality of the 
equipment, if payment is not received within 90 days.  

Pricing: 

BRG Precision Products reserves the right to change prices without prior notification. Prices do not include taxes 
and BRG reserves the right to arrange for insurance on all orders.  

The courts of Sedgwick County, Kansas will have exclusive jurisdiction and venue over any disputes arising from any 
sale by BRG and customer and Buyer consent to personal jurisdiction of the federal and state courts located in 
Sedgwick County, Kansas. If legal action is brought by BRG for the collection of any amount owed or due to any 
other dispute, the prevailing party will be entitled to recover its reasonable attorneys' fees and costs incurred. 
These items constitute the entire agreement between BRG and customer, regardless of any additional or conflicting 
terms on customer's purchase order or other documentation, which are objected to, or any prior discussions or 
usages of trade. All sales by BRG are made only on the terms and conditions contained herein.  

 
 



 

BRG Control Software License Agreement 

BRG Control Software, © Copyright 2024, BRG Precision Products, Inc. 

IMPORTANT!   

CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS.   

THE SOFTWARE, INCLUDING ITS CODE, DOCUMENTATION, APPEARANCE, STRUCTURE AND ORGANIZATION, IS A PROPRIETARY PRODUCT 
OF BRG PRECISION PRODUCTS, INC. AND IS PROTECTED BY COPYRIGHT AND OTHER LAWS.  TITLE TO THE SOFTWARE, OR ANY COPY, 
MODIFICATION OR MERGED PORTION OF THE SOFTWARE, SHALL AT ALL TIMES REMAIN WITH BRG PRECISION PRODUCTS, INC. 

License Agreement 

BRG Precision Products, Inc. grants the purchaser a non-exclusive, nontransferable license to use the BRG Control Program (the "Software”) 
on any number of computers owned and or operated by the purchaser.  You may install the software onto the hard disks of computers, or 
make it accessible to any number of computers owned and/or operated by the purchaser on a network, and you may make a copy of the 
software disk(s) for backup purposes.  These copies must include the BRG Precision Products, Inc. copyright notice. 

The software, including its graphics displays are copyrighted.  You may not: rent, distribute or transfer copies of the software or 
documentation to others outside your organization; modify, disassemble, decompile, or translate the software or documentation; make any 
copies of software modules for use with other programs; or use the software on terminals of a network, on a multi-user computer system 
not owned by the purchaser. 

This license is effective until terminated.  You may terminate it at any time by destroying all copies of the software.  It will also terminate 
automatically if you fail to comply with any of the terms and conditions of the Agreement.  Upon termination of this license for any reason, 
you agree to return or destroy all copies of the software. 

This Agreement constitutes the entire agreement and understanding between the parties and supersedes any prior agreements, 
representations, or understandings, whether oral or written, relating to the Software. 

This Agreement shall be governed by the laws of the State of Kansas. 

Limited Warranty 

BRG Precision Products, Inc. warrants that the original software disk(s) are free from physical defects in material and workmanship under 
normal use for a period of sixty days from the date of purchase.  If during this warranty period you discover that the software disk(s) contains 
a physical defect, return the defective item along with proof of purchase to BRG Precision Products, Inc. and you will receive a replacement 
at no charge.  This is your sole and exclusive remedy for breach of warranty.   

THE WARRANTY SET FORTH ABOVE IS EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED.  BRG PRECISION 
PRODUCTS, INC. MAKES NO WARRANTY OR REPRESENTATION, EXPRESS, IMPLIED OR STATUTORY WITH RESPECT TO THIS SOFTWARE, ITS 
QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE, THIS SOFTWARE IS SOLD "AS IS", AND YOU, THE 
LICENSEE, ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE. 

IN NO EVENT SHALL BRG PRECISION PRODUCTS, INC. BE LIABLE FOR DIRECT OR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES RESULTING FROM THE USE OF THE SOFTWARE OR FROM ANY ERROR OR DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, 
SUCH DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF PROFIT, LOSS OF SOFTWARE OR DATA, AND DAMAGE TO YOUR MONITOR, IN 
NO EVENT SHALL BRG PRECISION PRODUCTS, INC.  LIABILITY EXCEED THE PRICE PAID FOR THE SOFTWARE. 

The above exclusions may not apply to you.  This warranty provides you with specific legal rights.  There may be other rights that you may 
have which vary from state to state. 

     



 

BRG Firmware License Agreement 
 

BRG Firmware, © Copyright 2024, BRG Precision Products, Inc. 

THE FIRMWARE, INCLUDING ITS CODE, DOCUMENTATION, APPEARANCE, STRUCTURE AND ORGANIZATION, IS A PROPRIETARY PRODUCT 
OF BRG PRECISION PRODUCTS, INC. AND IS PROTECTED BY COPYRIGHT AND OTHER LAWS.  TITLE TO THE FIRMWARE, OR ANY COPY, 
MODIFICATION OR MERGED PORTION OF THE FIRMWARE, SHALL AT ALL TIMES REMAIN WITH BRG PRECISION PRODUCTS, INC. 

License Agreement 

BRG Precision Products, Inc. grants the purchaser a non-exclusive, nontransferable license to use the BRG Firmware (the "Software” program 
stored in processors and/or memory) on hardware manufactured by BRG Precision Product’s, Inc.  

The software is copyrighted.  You may not: rent, distribute or transfer copies of the software; modify, disassemble, decompile, extract from 
the hardware, or translate the software or documentation; make any copies of software modules for use with other programs. 

This license is effective until terminated.  You may terminate it at any time by discontinuing the use of the hardware containing the software.  
It will also terminate automatically if you fail to comply with any of the terms and conditions of the Agreement.  Upon termination of this 
license for any reason, you agree to discontinue the use of the software. 

This Agreement constitutes the entire agreement and understanding between the parties and supersedes any prior agreements, 
representations, or understandings, whether oral or written, relating to the Software. 

This Agreement shall be governed by the laws of the State of Kansas. 

Limited Warranty 

BRG Precision Products, Inc. warrants that the processors or memory use to store the software is free from physical defects in material and 
workmanship under normal use for a period of sixty days from the date of purchase.  

THE WARRANTY SET FORTH ABOVE IS EXCLUSIVE AND IN LIEU OF ALL OTHERS, ORAL OR WRITTEN, EXPRESS OR IMPLIED.  BRG PRECISION 
PRODUCTS, INC. MAKES NO WARRANTY OR REPRESENTATION, EXPRESS, IMPLIED OR STATUTORY WITH RESPECT TO THIS SOFTWARE, ITS 
QUALITY, PERFORMANCE, MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE, THIS SOFTWARE IS SOLD "AS IS", AND YOU, THE 
LICESEE, ARE ASSUMING THE ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE. 

IN NO EVENT SHALL BRG PRECISION PRODUCTS, INC. BE LIABLE FOR DIRECT OR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL 
DAMAGES RESULTING FROM THE USE OF THE SOFTWARE OR FROM ANY ERROR OR DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION, 
SUCH DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, LOSS OF PROFIT, LOSS OF SOFTWARE OR DATA, AND DAMAGE TO YOUR MONITOR, IN 
NO EVENT SHALL BRG PRECISION PRODUCTS, INC.  LIABILITY EXCEED THE PRICE PAID FOR THE SOFTWARE. 

The above exclusions may not apply to you.  This warranty provides you with specific legal rights.  There may be other rights that you may 
have which vary from state to state. 

 


